Release Notes for MyPBX U100&U200

Version 15.19.0.X

Yeastar Information Technology Co. Ltd.
Firmware Version: V15.19.0.49

Applicable Model: MyPBX U100&U200

Release Date: February 17, 2017

New Feature

1. Added the support for UC15 3G module.
Release Notes for MyPBX U100&U200 15.19.0.X

==Firmware Version: V15.19.0.48==
Applicable Model: MyPBX U100&U200
Release Date: December 18, 2015

**NOTE:**
We strongly recommend you to back up the configurations and all the files before you upgrade.

- Backup files from 15.18.0.X cannot be restored to the device with firmware version 15.19.0.X.
- Backup files from higher firmware version cannot be restored to the device with lower firmware version.
- You need to RESET the device to make it work properly if you downgrade the firmware.
- Please clear the browser’s cache after upgrade.

**New Feature**

2. Added the TA provisioning for TA100/200.
3. Added the specific call parking with feature code *06.

**Optimization**

1. Added the update of web language in German. German system prompts will be updated soon as well.
2. MyPBX will add the Accept rules for the TA gateway which is provisioned by TA Provisioning in the firewall.

**Bug Fixes**

1. Fixed the issue that the hints watchers value would increase when IP phone BLF keys monitored the unregistered extensions of MyPBX and that further would lead to system crash.
2. Fixed the issue that the line "#include XXX.conf" in extensions_custom.conf wouldn’t take effect.

3. Fixed the issue that Pulse Dialing was unavailable when using the V2.1 S2 module.

4. Fixed the issue that system would crash if the Recording Add-on was enabled within 1-2 hours for version X.19.0.47.

5. Fixed the issue that MyPBX couldn’t obtain the DNS address from the DCHP server.

6. Fixed the issue that Phone Book page would keep loading when you clicked the edit button if there were about 100 contacts in it.

7. Fixed the issue that LDAP contacts wouldn’t be deleted in the background system if the Nickname field contained the space character, even though you had deleted it on the web interface.

8. Fixed the issue that Fanvil I20/C58/C66 couldn’t download phone book from MyPBX.
Release Notes for MyPBX U100&U200 15.19.0.X

Firmware Version: V15.19.0.47

Applicable Model: MyPBX U100&U200

Release Date: September 14, 2015

NOTE:

We strongly recommend you to back up the configurations and all the files before you upgrade.

- Backup files from 15.18.0.X cannot be restored to the device with firmware version 15.19.0.X.
- Backup files from higher firmware version cannot be restored to the device with lower firmware version.
- You need to RESET the device to make it work properly if you downgrade the firmware.
- Please clear the browser's cache after upgrade.

New Feature

1. Added support for phone provisioning of Snom 710, 715, 720, 820, 821, 870 and Htek UC623, UC626, UC802, UC803, UC804, UC806, UC840, UC842, UC860, UC862.
2. Added support for MySMS.
3. Added support for TF card.
4. Added support for Myanmar Time Zone +6.5.
5. Added Afrikaans system prompt.
6. Added “Linear” ring strategy for Queue.
7. Added support for GSM V2.0 Module.
9. Added “Input Digit Timeout” setting for “Feature Code”.

Yeastar
Optimization

1. Optimized “Business Hours” description.
2. “User Name” and “Password” length for PPPOE settings is extended to 127 characters.
3. MyPBX administrator could change other accounts’ password without entering the old password.
4. The character “+” is allowed in “custom country code” field on “SMS Settings” page.
5. Alphabetic characters are allowed in “Prepend” field for an outbound route.
6. LDAP contacts were extended from 300 to 1000.
7. The audio file generated in “DAHDI Monitor Tool” is split into two files, one records received voice, one records transmitted voice.
8. MyPBX will back up the Linux log file /var/log/messages to /persistent folder if the messages file gets large. The messages file records a variety of events, including system error messages, system startups, and system shutdowns.
9. MyPBX will store “Fax to Email” temporary files to /persistent folder.
10. The Backup file contains custom configuration files and custom script files, does not contain custom prompts.
11. After resetting MyPBX, all the configurations including custom configuration files and custom script files will be deleted.

Bug Fixes

- MyPBX Related Bugs

1. Fixed the issue that custom configuration files, users_custom.conf, sip_custom.conf and sipsettings_custom.conf could not take effect.
2. Fixed the issue that there would no new call log created if the system stored a large amount of call logs.
3. Fixed the issue that a user dialed “*2” to check voicemail, after he/she pressed “#”, the system did not hang up the call but established an outbound call to “*2”.

Yeastar
4. Fixed the issue that if a ring group’s name contained a character “~”, it could not be selected in an IVR.

5. Fixed the issue that users could not set a password with special characters [:.,] for a IAX VoIP trunk.

6. Fixed the issue that when creating a new VoIP trunk, the “Realm” and “Authenticating Incoming Call” settings would disappear if you change the trunk type from “IAX” to “SIP”.

7. Fixed the issue that a 3rd party software could not read the correct trunk’s name from MyPBX via AMI if the trunk name length was too long.

8. Fixed the issue that the extension status on MyPBX web indicated “Registered” even the extension was not registered.

9. Fixed the issue that the FTP status on “Security→ Service” page always showed “Enabled” even the FTP service was disabled.

10. Fixed the issue that when registering a VoIP trunk, MyPBX sent a REGISTER request with 5060 SIP port even the SIP port was changed, which caused incoming calls fail to reach the VoIP trunk.

11. Fixed the issue that T.38 fax for SIP trunk could not work properly.

12. Fixed the issue when calling in an IVR and dialed an extension number but no one answered the call, the call log marked the call as “ANSWERED”.

13. Corrected prompts for SMTP setting (from “Use SSL/TLS to send secure message to server” to “Use TLS for security on this server(SMTP)” ) that indicates MyPBX did not support SSL.

14. Fixed the issue that when the system prompt was set to “French”, “Follow Me Prompt” (PBX→Basic Settings→General Preferences) setting could not take effect.

15. Fixed the issue that transfer feature could not work for mobility extensions.

16. Fixed that issue that BLF key feature could not work for the extension whose “Register Name” and “Name” were different

17. Fixed the issue that the BLF LED was on even the monitored extension was unavailable.

18. Fixed the issue that the call log could not display the IAX service provider trunk’s name correctly if the trunk was registered using a domain.
19. Fixed the issue that the HDD usage rate was too low that only few recording files were stored.

20. The country code “Yugoslavia +381” was corrected to “Serbia +381”.


22. Fixed the issue that Grandstream IP phones displayed wrong date and time after rebooting if “Phone Provisioning” was configured for the phones.

23. Fixed the issue that phone provisioning for Panasonic could not work for MAC address starts with “0080”.

24. Fixed the issue that phone provisioning for Cisco 7960 and 7940 could not work.

25. Fixed the issue that “Deutsch” language for Yealink phones could not work.

26. Fixed the issue that if the default SIP port was changed on MyPBX and used “TA Provisioning” feature to configure a TA gateway, the SIP port for TA gateway was incorrect.

➤ **Auto Recording**

1. Fixed the issue that the auto recording manager had no permission to check some extensions’ recording logs, but the recording logs for the extensions might be checked by the manager.

2. Fixed the issue that if an extension’s caller ID was changed, the auto recording manager could no longer check the extension’s recording logs.

➤ **Billing**

1. Fixed the issue that when billing add-on was enabled, an extension might not be able to make calls even the balance for the extension was enough.

2. Fixed the issue that the transfer call logs in Billing System add-on was incorrect.

3. Fixed the issue that the extension would be charged even the billing duration for the call was 0.

4. The search condition for call logs is optimized. Users could search call logs by exact time.
Hotel

1. Fixed the issue that if booking a room directly from “Customer List”, a same customer record would be created in the Customer List.

2. Fixed the issue that the user could not check in as hourly room if the selected room supported hourly room.

3. The “Model Management” setting was removed from “Room Management”, and can be found in the left-hand navigation directly.

New Feature (Instruction)

1. Added support for MySMS.

Path: System → Security Settings → AMI Settings

Instruction:

MySMS is software developed by Yeastar that helps you to send SMS on free Web messaging platform.

More information of MySMS here: [http://www.yeastar.com/Solutions/MySMS_Web_SMS_Center](http://www.yeastar.com/Solutions/MySMS_Web_SMS_Center)

To connect MyPBX and MySMS, you need to enable AMI on MyPBX and add the permitted IP address.

Note: make sure that GSM/UMTS/CDMA module is available on MyPBX.
2. **Added support for TF card.**

   **Path:** System → Storage Management → TF Card

   **Instruction:**

   TF card is supported on MyPBX U100/U200 with hardware version above 2.0. Users could choose to store recording files into TF card. If the storage of TF card is full, call recordings would be stored in an available USB device.

3. **Added support for Myanmar Time Zone +6.5.**

   **Path:** System → System Preferences → Date and Time

   **Instruction:**

4. **Added Afrikaans system prompt.**

   **Path:** PBX → Audio Settings → System Prompts Settings

   **Instruction:**
5. **Added “Linear” ring strategy for Queue.**

**Path:** PBX → Inbound Call Control → Queues

**Instruction:**

If choose the “Linear” strategy, the system will rings agents in the order they are listed in the configuration file.

6. **Added support for GSM V2.0 Module.**

**Instruction:**

The new GSM module is marked as “GSM V2.0”
7. **Users could search call logs with “Exactly Match” feature.**

   **Path:** Reports→ Call Logs

   **Instruction:**
   Tick the “Exactly Match” option and type exact Caller/Callee number to search call logs.

8. **Added “Input Digit Timeout” setting for “Feature Code”.**

   **Path:** PBX→ Basic Settings→ Feature Codes

   **Instruction:** set the timeout to input next digit.
Optimization (Instruction)

1. Optimized “Business Hours” description.

   **Path:** PBX → Basic Settings → Business Hours

   **Instruction:**

   Using the Day/Night control, the users can override the time settings and force all calls to the destinations as they wish, ignoring the office time.

   - **Force to Night Mode:** dial *81 to switch to night mode (office closed mode), all calls will go to Night destination.

   - **Force to Day Mode:** dial *82 to switch to day mode (office open mode), all calls will go to Day destination.

   - **Revert to the Original Mode:** dial *081 to revert to the original mode, calls will go to the relevant destination according to the office time.
2. “User Name” and “Password” length for PPPOE settings are extended to 127 characters.

**Path:** System → Network Preferences → WAN Settings

**Instruction:**

![WAN Settings](image1)

3. MyPBX administrator could change other accounts' password without entering the old password.

**Path:** System → System Preferences → Password Settings

**Instruction:**

To change other account's password, the administrator can type the new password directly.

![Change Password](image2)

4. The character “+” is allowed in “custom country code” field on “SMS Settings” page.

**Path:** PBX → Advanced Settings → SMS Settings

**Instruction:**

![SMS Settings](image3)
5. **Alphabetic characters are allowed in “Prepend” field for an outbound route.**

**Path:** PBX→Outbound Call Control→Outbound Routes

**Instruction:**

![Edit Outbound Route](image)

6. **LDAP contacts were extended from 300 to 1000.**

**Path:** System→LDAP Server

**Instruction:**

You can add up to 1000 contacts in the phone book.

![LDAP Phone Book](image)
Note:

- We strongly recommend you to back up the configurations and all the files before you upgrade.
- Please note you may have to RESET the device to make it work properly after upgrade.
- Backup files from 15.18.0.X cannot be restored to the device with firmware version 15.19.0.X.
- Backup files from higher firmware version cannot be restored to the device with lower firmware version.
- Please clear the browser's cache after upgrade.

New Features


Path: PBX→Extensions→Phone Provisioning
Optimization

1. **Office Hours can be set down to the minute.**

   **Path:** PBX → Basic Settings → Business Hours
Bug Fixes

1. Fixed the issue that Line Monitoring (BLF) on Tiptel or Hanlong IP phone would fail after a period of time.

2. Fixed the issue that changes for “Tone Region” could not take effect (PBX→Basic Settings→General Preferences).

3. Fixed the issue that attended transfer could not work properly when using Spectralink IP phone.
Release Notes for MyPBX U100&U200 15.19.0.X

===Firmware Version: V15.19.0.43====

Applicable Model: MyPBX U100&U200

Release Date: January 15th, 2015

NOTE:

- Please note that if you upgrade from version 15.19.0.30 to version 15.19.0.43, you may have to RESET the device to make it work well, all the former configurations and records will lose.

- Backup files from 15.19.0.30 cannot be restored and will not work properly on the device with firmware version 15.19.0.43.

- Backup files from 15.18.0.X cannot be restored to the device with firmware version 15.19.0.X.

- Backup files from higher firmware version cannot be restored to the device with lower firmware version.

- Please clear the browser's cache after upgrade.

New Features

1. Added support for CDMA module.
2. Added Hebrew system prompt.

Optimization

1. Added a system prompt after successfully logging in or logging out a queue. For example, the queue number is 680. An agent can dial 680* to log in the queue, then the system will prompt "agent logged in". If dialing 680** to log out the queue, the system will prompt "agent logged out".

2. Added a note “Advise: When play record, please use Google or Firefox browser with Flash plugin,” on Record Logs page (Log in MyPBX by “monitor” account, Report→Record Logs).
3. To avoid DTMF signals incorrect detection, the default Rxgain value on GSM trunk was adjusted from 40% to 60%. **Rxgain** is for received volume, increasing this value means increasing the received volume.

**Bug Fixes**

1. Fixed the issue that the query for mobility extensions would fail if the number of mobility extensions were more than the maximum extensions supported on MyPBX.
2. Fixed the issue that when calling a ring group without answer, there was no “missed call” displayed on the ring group member’s phone.
3. Fixed the issue that there were no **“MAC Address”** and **“Phone Type”** fields when editing Cisco phones on **Phone Provisioning** Page.
4. Fixed the issue that the PPPoE network could not connect automatically if the network cable was disconnected and connected again.

**New Features (Instruction)**

1. **Added support for CDMA module.**

   Previously, MyPBX only supported GSM and UMTS module; in this version, MyPBX added support for CDMA module.

   - **GSM Module:** including SIM900 and SIM800 Module support 850/900/1800/1900 MHz (Dual Band)
• **UMTS Module**: including SIM5215E and SIM5215J Module
  
  1) **SIM5215E**: Dual-Band UMTS/HSDPA 900/2100MHz  
      Quad-Band GSM/GPRS/EDGE 850/900/1800MHz  
  
  2) **SIM5215J**: Dual-Band UMTS/HSDPA 850(800)/2100MHz  
      Quad-Band GSM/GPRS/EDGE 850/900/1800/1900MHz  

• **CDMA Module**: SIM2000C Module, supports 800MHZ

2. **Added Hebrew system prompt.**
   
   **Path:** PBX→AudioSettings→System Prompt Settings
   
   **Instruction:**

   ![Screenshot of System Prompts Settings](image.png)
==Firmware Version: V15.19.0.42====

Applicable Model: MyPBX U100&U200

Release Date: November 27th, 2014

NOTE:

- We strongly recommend you to back up the configurations and all the files before you upgrade.
- Please note you may have to RESET the device to make it work properly after upgrade.
- Backup files from 15.18.0.X cannot be restored to the device with firmware version 15.19.0.X.
- Backup files from higher firmware version cannot be restored to the device with lower firmware version.
- Please clear the browser's cache after upgrade.

New Features

1. Added Pickup Call info on Call Logs page.
2. Added a "monitorpath" field in CDR database.
3. Added Rxgain and Txgain Settings on GSM trunk.
4. SSH and FTP Settings on LAN Settings page will take effect without rebooting.
5. Added support for using BLF key to monitor and capture PSTN trunks and GSM/UMTS trunks.
6. Added "Authenticating Incoming Call" on VoIP trunk.
7. Added "mypbxconf" execution interface for API.
8. Added Password settings for NeoGate Provisioning.
Bug Fixes

1. Fixed the issue that DND setting could not take effect for the extension which was selected in a ring group.

2. Fixed the issue that the configured “View” number on Extension page and Phone Provisioning page could not be fixed if any change was made on the page.

3. Fixed the issue that wakeup call could not work in Hotel Addon.

4. Fixed the issue that call queues could not be deleted if users logged in MyPBX French Web GUI.

Instruction (New Features)

1. **Added Pickup Call info on Call Logs page.**
   
   **Instruction:**
   
   When a call was picked up by other user, you can check the pick up call info on Call Logs page. For example, the Callee shows “300(301)”, it means that extension 300 is the callee, and extension 301 is the one who picked up the call.

2. **Added a “monitorpath” field in CDR database.**
   
   **Instruction:**
   
   A CDR data table named cdr_yyyyymm (yyyy indicates Year, mm indicates Month, i.e. cdr_201411) will be created in MyPBX after a successful call recording, and you can check the save path by the “monitorpath” field.

3. **Added Rxgain and Txgain Settings on GSM trunk.**
   
   **Path:** PBX→Trunks→Physical Trunks
   
   **Instruction:**
4. SSH and FTP Settings on LAN Settings page will take effect without rebooting.

**Path:** System→Network Preferences→LAN Settings

**Instruction:**

![](image1)

5. Added support for using BLF key to monitor and capture PSTN trunks and GSM/UMTS trunks.

**Instruction:**

You can configure BLF keys on your IP phone to monitor PSTN trunks and GSM/UMTS trunks. Also, you can press the configured BLF key to capture the trunks to make outbound calls.

![](image2)

6. Added “Authenticating Incoming Call” on VoIP trunk.

**Path:** PBX→Trunks→VoIP Trunks

**Instruction:**

When an incoming call reaches MyPBX and sends INVITE packet to MyPBX,
MyPBX responds 401, but the Realm info in 401 Response does not match the Realm set on VoIP trunk, the provider will refuse to authenticate. If you set this option to No, MyPBX will not reply a 401 Response to the provider to authenticate the incoming call.

7. Added “mypbxconf” execution interface for API.

Instruction:

This is an interface for developer. You can connect a 3rd party software to MyPBX via API. A corresponding configuration file will be updated or created in MyPBX if changes were applied on the 3rd party software. For example, you create an extension 300 on the software. You will find the user 300 is added to MyPBX extensions.conf file.

8. Added Password settings for NeoGate Provisioning.

Path: PBX→Extensions→NeoGate Provisioning

Instruction:
Release Notes for MyPBX U100&U200 15.19.0.X

==Firmware Version: V15.19.0.41====

Applicable Model: MyPBXU100&U200

Release Date: October 31th, 2014

NOTE:

- We strongly recommend you to back up the configurations and all the files before you upgrade.
- Please note you may have to RESET the device to make it work properly after upgrade.
- Backup files from 15.18.0.X cannot be restored to the device with firmware version 15.19.0.X.
- Backup files from higher firmware version cannot be restored to the device with lower firmware version.
- Please clear the browser’s cache after upgrade.

New Features

1. Added NeoGate Provisioning feature.
2. Supports DDNS Server “www.oray.com” and “3322.org”.
3. Added “DAHDI Monitor Tool” and optimized “Debug Log” settings on System Logs
4. Added “Urgent” type voicemail.

5. Added Custom Language Setting for Yealink Phone Provisioning.

6. Supports phone provision for Grandstream IP phone GXP 2130, 2140, 2160 and Yealink T46G.

7. Added a communication type “Transfer” for searching the CDR on “Call Log” page.

Bug Fixes

➢ PBX Related

1. Fixed the issue that the system had no self-repair ability when huge data stored in the database resulted to malfunction of the system.

2. Fixed the issue that the database stored in NAS server could not be repaired.

3. Fixed the issue that if users pressed the BLF key (which was configured to monitor a PSTN line) to catch a PSTN line to make an outbound call, there was no auto recording for the call.

4. Fixed the issue that the “Delete” button and “Download” button could not work correctly.

5. Fixed the issue that the “Follow me” setting on MyPBX could not work if “Follow me” was also set on IP phones.

6. Fixed the issue that Call Pickup (default feature code *4) feature could not work between a SIP extension and an IAX extension.

7. Fixed the issue that “Enable Forward All Calls” feature (default feature code *71) could not work if the extension “Caller ID” setting was changed.

8. Fixed the issue that the recordings for the calls which were made to MyPBX queues could not be queried by the Auto Recording Managers.

9. Fixed the issue that “T38 Max BitRate” setting on SIP Settings → T.38 could not work.

10. Fixed the issue that two identical recording files would be created on MyPBX “Custom Prompts” page if using Yealink VP530 IP phone to make a recording.
11. Fixed the issue that the LDAP server could not be enabled after applying the changes with blank password.

12. Fixed the issue that the system would download the same voice mail file if you didn’t update the page after downloading the former file.

13. Fixed the issue that call waiting could not work for analog phones even if call waiting was supported on the phone.

14. Fixed the issue that the extension and the corresponding mobility extension could not ring simultaneously if the extension was in a ring group.

15. Fixed the issue that an incoming call could not reach the extension but only the mobility extension if there was password set on the outbound route.

16. Fixed the issue that the system could not resolve the Domain (which was set on DDNS page) timely.

17. Fixed the issue that call logs were incorrect when there were multiple VoIP SIP trunks with the same IP/domain registered on MyPBX.

18. Fixed the issue that the caller could not hear ring back tone when he/she called in SIP trunk on MyPBX and the call was routed to an external number through BRI trunk on MyPBX.

19. Fixed the issue that the DOD numbers configured on MyPBX trunks could not be deleted successfully.

20. Fixed the issue that UMTS modules would be detected as GSM modules.

21. Fixed the issue that the inbound call to MyPBX PSTN trunk would not be detected if the ring tone sent to MyPBX was at 25hz.

22. Fixed the issue that the maximum number for Russian characters in Phone Book “Nick Name” field was 32.

23. Fixed the issue that the prompt files could not be played periodically according to the time set on queues.

24. Fixed the issue that there would be two duplicated alarm records on the Call Log page if the alarm call was rejected.

25. The characters [space ; - +] are not allowed in LDAP “Password” filed; and the characters [- < >] are not allowed in Phone Book “Nick Name” field.
26. Fixed the issue that when there were two outbound routes with the same "Dial Pattern", DOD number set on the trunk (which was selected on the second outbound route) would not work.

27. Fixed the issue that when a VoIP trunk was registered on MyPBX, and an inbound route without "DID number" settings for this VoIP trunk was created, if the incoming DID number didn't match the "User Name" set on the VoIP trunk, the call would fail.

➢ Hotel Add-on

1. Fixed the issue that a space character would be displayed as “+” on the bill.
2. Fixed the issue that the bill would be incorrect if the “Caller ID” was changed on extension page.
3. Fixed the issue that the "Gender" on customer info page could not be changed after check in.

➢ Billing Add-on

1. Fixed the issue that a “#” character could not be accepted in the “Emergency Number” field.

➢ MyPBX Client

1. Fixed the issue that there was no pop-up call on MyPBX Client when the incoming call reached a queue or a ring group.

Instruction (New Features)

1. Added NeoGate Provisioning feature.
   Path: PBX→Extensions→NeoGate Provisioning
Instruction:

With this feature, you can easily configure the NeoGate TA on MyPBX, saving your time and efforts. Click “Add NeoGate” and fill in the corresponding information in the pop-up window, save and apply, the configurations will be applied to NeoGate TA.

Two Methods are supported for NeoGate provision: PnP and DHCP.

Choose the method on NeoGate TA “Auto Provisioning Settings” page.

If DHCP method is selected on NeoGate TA, you should enable DHCP Server on MyPBX (System → Network Preferences → DHCP Server).
2. **Supports DDNS Server “www.oray.com” and “3322.org”**.
   
   **Path:** PBX→Extensions→NeoGate Provisioning
   
   **Instruction:**
   
   You can sign up for service through “www.oray.com” and “3322.org”, then take the account to configure in MyPBX DDNS Settings.

3. **Added “DAHDI Monitor Tool” and optimized “Debug Log” settings on System Logs page.**
   
   **Path:** Reports→Reports→System Logs
   
   **Instruction:**
   
   Making records for PSTN/GSM trunks to do trouble shooting is no longer a trouble when using this tool.

   You can trace different debug logs by configuring the Debug Level.

4. **Added “Urgent” type voicemail.**
   
   **Path:** PBX→Basic Settings→Voicemail Settings
Instruction:

To mark the voicemail as an “Urgent” one, you should check the option “Allow Users to Review Messages”. After the caller leave the message and press # key, a prompt will be played.

Press 1 to accept this recording.

Press 2 to listen to it.

Press 3 to re-record your message.

Press 4 to mark this message as “Urgent”.

The urgent voicemail can be checked on the User Web Interface.

Or you can notice that there are urgent voicemails if you press *2 on your IP phone to check voicemails.

5. Added Custom Language Setting for Yealink Phone Provisioning.

Path: PBX → Extensions → Phone Provisioning → General Settings for Yealink

Instruction:
6. Supports phone provision for Grandstream IP phone GXP 2130, 2140, 2160 and Yealink T46G.

Path: PBX→Extensions→Phone Provisioning

Instruction:
7. **Added a communication type “Transfer” for searching the CDR on “Call Log” page.**

*Path: PBX→Reports→Reports→Call Logs*

**Instruction:**

* ===Firmware Version: V15.19.0.30====*

*Applicable Model: MyPBXU100&U200*

*Release Date: August 12th, 2014*

**NOTE:**

- We strongly recommend you to back up the configurations and all the files before you upgrade.
- Please note you may have to RESET the device to make it work properly after upgrade.
- Backup files from 15.18.0.X cannot be restored to the device with firmware version 15.19.0.X.
- Backup files from higher firmware version cannot be restored to the device with lower firmware version.
- Please clear the browser's cache after upgrade.

**New Features**

1. Added Fanvil Phone type C01, C66, D800, D900, F52, F58, F66 for phone provisioning.
2. Added "DTMF Detect Mode" and "DTMF Detect Sensitive" options on GSM trunk edit page.
3. Added "Echo Cancellation Algorithm" option on "General Preferences" page.

**Optimization**

1. The number of PIN code in a PIN list is limited to same number of extensions supported on MyPBX. (Maximum 100 PIN codes on U100; Maximum 200 PIN codes on U200.) The length of each PIN code is limited to 8 characters.

**Bug Fixes**

1. Fixed the issue that the Module UMTS SIM5215J could not work properly, resulting in SIM card detection failure.
2. Fixed the issue that batch deleting of auto recording managers would fail.
3. Fixed the issue that the auto recording could not work if you set network disk to NAS (Network Attached Storage), even if the running status showing "mounted".
4. Fixed the bug that DTMF detection was too sensitive that the voice would be detected as a DTMF signal by error or a "beep" sound would appear during the call.
5. Fixed the issue that the GSM module could not be detected if the firmware was upgraded from version 15.18.0.X to version 15.19.0.X.
6. Fixed the issue that changes on the Outbound Route edit page could not be saved when a password with a 63-character name was chosen.

7. Fixed the issue that changes on the DISA edit page could not be saved when a password with a 63-character name was chosen.

Instruction (New Features)

1. Added Fanvilphone type C01, C66, D800, D900, F52, F58, F66 for phone provisioning.

Path: PBX → Extensions → Phone Provisioning

Instruction:

2. Added "DTMF Detect Mode" and "DTMF Detect Sensitive" options on GSM trunk edit page.

Path: PBX → Trunks → Physical Trunk → GSM/UMTS Trunk
Instruction:

DTMF signals sent to GSM trunk are different, that's why we need to configure these two options to make DTMF detected correctly on MyPBX.

![Edit GSM Trunk - GSM9](image)

3. Added "Echo Cancellation Algorithm" option on "General Preferences" page.

Path: PBX → Basic Settings → General Preferences

Instruction:

This option is used to adjust the echo cancellation on PSTN/GSM trunk.

Choose the algorithm to get a better call quality according to your trunks. The default setting is "aer".

![General Preferences](image)

If you choose "oslec", you should set the "Echo Training", the default is 16ms.
Instruction (Optimization)

1. The number of PIN code in a PIN list is limited to same number of extensions supported on MyPBX. (Maximum 100 PIN codes on U100; Maximum 200 PIN codes on U200.) The length of each PIN code is limited to 8 characters.

Path: PBX→Advanced Settings→PIN Settings

Instruction:
Release Notes for MyPBX U100&U200 15.19.0.X

---Firmware Version: V15.19.0.23---

Applicable Model: MyPBXU100&U200

Release Date: April 8th, 2014

NOTE:

- We strongly recommend you to back up the configurations and all the files before you upgrade.
- Please note you may have to RESET the device to make it work properly after upgrade.
- Backup files from 15.18.0.X cannot be restored to the device with firmware version 15.19.0.X.
- Backup files from higher firmware version cannot be restored to the device with lower firmware version.
- Please clear the browser’s cache after upgrade.

Bug Fixes

1. Fixed the issue that the default “Yes” setting for DSP FAX would not take effect.

2. Fixed the issue that the "Storage Location" would be set to "Network Disk" by default, which caused the recording files missing.

3. Fixed the issue that outgoing calls through BRI trunk would be disconnected immediately.
Release Notes for MyPBX U100&U200 15.19.0.X

---Firmware Version: V15.19.0.21---

Applicable Model: MyPBX U100&U200

Release Date: March 26th, 2014

Contents:

Part 1: MyPBX ................................................................. 43
  1. New Features........................................................... 45
  2. Optimization......................................................... 45
  3. Bug Fixes.............................................................. 46
  4. Instruction (New Features) ........................................ 46
  5. Instruction (Optimization) ........................................ 58

Part 2: Recording Addon .................................................. 62
  1. New Features........................................................... 62
  2. Bug Fixes.............................................................. 63
  3. Instruction (New Features) ........................................ 63

Part 3: Billing System Addon ............................................. 67
  1. New Features........................................................... 67
  2. Bug Fixes.............................................................. 67
  3. Instruction (New Features) ........................................ 67

Part 4: Hotel Addon .......................................................... 73
  1. New Features........................................................... 73
  2. Optimization......................................................... 73
  3. Bug Fixes.............................................................. 73
  4. Instruction (New Features) ........................................ 73
  5. Instruction (Optimization) ........................................ 73
Part 5: MyPBX Client Addon

1. New Features

2. Bug Fixes

3. Instruction (New Features)

Part 1: MyPBX

NOTE:

- We strongly recommend you to back up the configurations and all the files before you upgrade.
- Please note you may have to RESET the device to make it work properly after upgrade.
- Backup files from 15.18.0.X cannot be restored to the device with firmware version 15.19.0.X.
- Backup files from higher firmware version cannot be restored to the device with lower firmware version.
- After upgrade, please clean the cache and cookies of the browser before login.
- Please reboot the device twice to make the new firmware take effect.
- There is a compatibility issue with IE11. Please configure IE11 browser "Compatibility View Settings", add MyPBX IP address, check "Display Intranet sites in Compatibility View" and "Use Microsoft compatibility lists". Check the following picture, MyPBX IP is 192.168.5.250 for example.
New Features

1. Added LDAP Service option.
2. Added Panasonic IP phones in "Phone Provisioning".
3. Added Yealink latest IP phone model "T19P","T21P" in "Phone Provisioning".
4. Added HTTPS protocol.
5. Added separated backup support for extensions.
6. Added FTP Enable and Disable option on "LAN Settings" page.
7. Added "*Answer" mode for "Paging Groups".
8. Added L2TP VPN and IPSec VPN.
9. Added "PIN Settings" page, where users can manage all the passwords of outbound routes, PIN User, and DISA.
10. Added multiple "Dial patterns" on outbound routes.
11. Added "Answer Detection" option for PSTN line to achieve accurate billing.
12. Added "ISDN Diaplan" and "Dialplan" options for BRI trunk.
13. Added a default TLS PBX certificate.
15. Added "Register Name" option for extensions.
16. Added the feature that the Mobility extension will ring as well if the corresponding extension is ringing.

Optimization

1. Random passwords are generated for newly created extensions.
2. Multiple SIP trunks can be deleted at once.
3. Multiple inbound routes and multiple outbound routes can be deleted at once.
4. The special character "-" is allowed in the field "Distinctive Ringtone" on inbound routes.
5. Added bulk DOD numbers.
6. Optimized the T.38 FAX.
7. Optimized the "WEBLOGIN" Alert.
8. Encrypted the backup file.

**Bug Fixes**

1. Fixed the issue that call log would show "ANSWERED" even if the call, which is made through GSM is not answered.
2. Fixed the issue that MyPBX would keep sending REGISTER packets even 200 OK response was already received.
3. Fixed the issue that MyPBX doesn't send REGISTER packet using the new nonce.
4. Fixed the issue that the status of SPX trunk (Service Provider IAX) on MyPBXB would be "Unreachable" if connecting MyPBX A (with dynamic IP and DDNS configured) and MyPBX B via the trunk.
5. Fixed the call log bugs:
   a. Webpage error would occur in the Call logs page if all the search conditions were selected.
   b. The call logs cannot be deleted if all the search conditions were selected.

**Instruction (New Features)**

1. **Added LDAP Service option.**

**Path:** System → LDAP Server

**Instruction:**

After enabling LDAP and configuring the settings, users are able to use LDAP Phone Book.
2. Added Panasonic IP phones in "Phone Provisioning".

Path: PBX → Extensions → Phone Provisioning → Add Phone

Instruction:

Panasonic IP phones are supported in Phone Provisioning; the models are UT113, UT123, UT133, UT136, UT248, UT670, TGP500, and TGP550.
3. Added Yealink latest IP phone model "T19P","T21P" in "Phone Provisioning".

Path: PBX→Extensions→Phone Provisioning→Add Phone

Instruction:

4. Added HTTPS protocol.

Path: PBX→General Preferences→Web Server→HTTPS

Instruction:

Users are able to log in MyPBX web GUI using https if the https is enabled.

5. Added separated backup support for extensions.

Path: System→System Preferences→Backup and Restore

Instruction:

Users are able to create a new backup for extensions and upload an "Extension" backup file.
6. Added FTP Enable and Disable option on "LAN Settings" page.

**Path:** System→LAN Settings→Backup and Restore

**Instruction:**

Users will be able to log in MyPBX via FTP if FTP is enabled.

7. Added "*Answer" mode for "Paging Groups".

**Path:** PBX→Advanced Settings→Paging Groups

**Instruction:**
Choose "Yes" for "*Answer" will enable any user in the group to press * to talk with the caller while other users automatically hang up the call.

8. Added L2TP VPN and IPSec VPN.

**Path:** System → VPN Settings

**Instruction:**

There are two more VPN supported on MyPBX, L2TP VPN and IPSec VPN.
9. Added "PIN Settings" page, where users can manage all the passwords of outbound routes, PIN User, and DISA.

Path: PBX ➔ Advanced Settings ➔ PIN Settings

Instruction:

All the passwords for outbound routes, PIN User, and DISA are managed in "PIN Settings". Users can create PIN lists and choose "Yes" for "Record In CDR", the PIN code will be displayed in call log.

The PIN list created in "PIN Settings" can be chosen in outbound route, DISA and PIN User.
10. Added multiple "Dial patterns" on outbound routes.

Path: PBX → Outbound Call Control → Outbound Routes

Instruction:

Users are able to set multiple dial patterns for one outbound route.
11. Added "Answer Detection" option for PSTN line to achieve accurate billing.

**Path:** PBX → Trunks → Physical Trunk → Analog Trunk

**Instruction:**

"Answer Detection" settings are configured for accurate billing. If the PSTN trunk sends polarity after answering the call, users can choose "Polarity Detection"; or else choose "Ring Detection", and configure the detailed settings according to the PSTN line ring tone.
12. Added "ISDN Dialplan" and "Dialplan" options for BRI trunk.

**Path:** PBX→Trunks→Physical Trunk→BRI Trunk

**Instruction:**

These settings are set to make the caller ID prefix work according to information sent from the BRI provider.
13. Added a default TLS PBX certificate.

Path: PBX→Advanced Settings→Certificates

Instruction:
There is already a default TLS PBX certificate in MyPBX. Users can upload trusted certificates to MyPBX to make it work. Or if a new PBX certificate is uploaded to MyPBX, the new file will take effect.


Path: PBX→Advanced Settings→SMS Settings

Instruction:
If Country code is enabled, users can use a custom country code, which makes it more flexible.

15. Added "Register name" option for extensions.

Path: PBX→Extensions→FXS/VoIP Extensions

Instruction:
The "Register Name" option is for extension authorization, which will enhance the extension registry security. Users will not be able register the extension if the authorization name is incorrect even though the username and password are correct. For example, we set "Register Name" as "abcd" for extension 300, we have to set
authorization name "abcd" on the soft phone or IP phone to make the extension successfully registered.
16. Added the feature that the Mobility extension will ring as well if the corresponding extension is ringing.

Instruction:

This function enables the users who are out of office to receive the incoming call to the corresponding extension.

Check the "Ring Simultaneously" option, fill in the "Mobile Extension Number" and fill
in the "Outbound Prefix" according to the outbound route dial pattern.

For example, if you set the outbound route dial pattern as 9. and strip 1 digit, then you should set 9 for the "Outbound Prefix".

Instruction (Optimization)

1. Random new passwords are generated for new created extensions.

Path: PBX→Extensions→FXS/VoIP Extensions

Instruction:

The default password for an extension was "pincode+extension number" before. (password "pincode100" for extension 100 for example )But now, there will be a random and robust password will be generated when creating a new extension.
2. Multiple SIP trunks can be deleted at once.

**Path:** PBX → Trunks → VoIP Trunk

**Instruction:**
3. Multiple inbound routes and multiple outbound routes can be deleted at once.

**Path:** PBX→Outbound Call Control→Outbound Routes

**Instruction:**

![Outbound Routes](image1)

**Path:** PBX→Inbound Call Control→Inbound Routes

**Instruction:**

![Inbound Routes](image2)

4. The special character "-" is allowed in the field "Distinctive Ringtone" on inbound routes.

**Path:** PBX→Inbound Call Control→Inbound Routes

**Instruction:**
5. Added bulk DOD numbers.

Instruction:

Users are able to add bulk DOD numbers on SIP trunk or BRI trunk.

6. Optimized the T.38 FAX.
**Path:** PBX→Advanced Settings→SIP Settings→T.38

**Instruction:**

Added advanced settings of T.38 for better receiving and sending of T.38 FAX.

---

7. Optimized the "WEBLOGIN" Alert.

**Path:** System→Security Settings→Alert Settings→WEBLOGIN

**Instruction:**

WEBLOGIN Alert is not only works for "admin" account, but also for other accounts.

---

8. Encrypted the backup file.

**Path:** System→System Preference→Backup and Restore

**Instruction:**

The backup created on MyPBX is encrypted with file format ".bak".

---

**Part 2: Recording Addon**

**New Features**

1. Added multi-level administrators for auto recording.
2. Added auto recording for conference.

3. Added "Network Disk settings" page, in which Network Disk can be configured to store recording files.

4. Added "Record Outbound Prompt" to prompt the callee that the call is being recorded.

**Bug Fixes**

1. Fixed the issue that the trunks will disappear and all the extensions cannot be displayed on "monitor" account Web GUI if there are lots of extensions with 7 digits. (for example, one extension number is 1234567)

**Instruction (New Features)**

1. Added multi-level administrators for auto recording.

**Path:** Advanced Settings → Auto Recording Management

**Instruction:**

Multiple managers can be created by the administrator. The manager will have the right to check auto recordings, delete recording files and download recording files. For example, create a manager for extension 601. Users can log in MyPBX by username "601" to manage the recording files of the selected extensions.
2. Added auto recording for conference.

Path: Network Preferences → Records Settings → Apply To

Instruction:
When ticked, all calls made by the selected conference will be recorded.
3. Added "Network Disk settings", in which Network Disk can be configured to store recording files.

**Path:** Advanced Settings → Network Disk Settings

**Instruction:**
After configuration, the recording files can be stored in a Window-based computer.

4. Added "Record Outbound Prompt" to inform the callee that the call is being recorded.

**Path:** Network Preferences → Records Settings → General Preferences

**Instruction:**
If "Record Outbound Prompt" is enabled, the callee will hear the preconfigured prompt when the outbound calls go through the trunks.
The custom prompt can be chosen if you have uploaded it to MyPBX "Custom Prompts" page.

**Path:** PBX → Audio Settings → Custom Prompts
Part 3: Billing System Addon

New Features

1. Billing precision is up to 4 digits after the decimal point.
2. Currency symbol can be edited by users.
3. Added "Insufficient Balance Prompt" option.
4. Added "Extension Locked Prompt" option.
5. Added "Emergency Number" option.
6. Added "Scheduled Task" settings to lock or recharge extensions, or recover balance for extensions periodically.
7. DISA and "Inbound-to-Outbound" features are available after enabling billing system.
8. Added billing for mobility extension.

Bug Fixes

1. Fixed the issue that calls made from insufficient extensions will be connected first then hung up.
2. Fixed the issue that the billing will not work if the rate is edited during a call.
3. Fixed the issue that the extension whose caller ID is changed cannot call out if billing system is enabled.
4. Fixed the issue that the billing starts as soon as the call is made through a PSTN line. This can be solved by configuring "Answer Detection" on PSTN trunk.
5. Fixed the issue that a call would not be disconnected if it went out of balance halfway through the call.

Instruction (New Features)

1. Billing precision is up to 4 digits after the decimal point.

Path: Addons → Billing Settings → Rate
Instruction:

Users are able to enter a rate value that has 4 digits after the decimal point and the billing precision is up to 4 digits after the decimal.

![Image of Edit Rate dialog]

2. Currency symbol can be edited by users.

Path: Addons → Billing Settings → General Settings

Instruction:

The Currency is editable by users. You are able to fill in any currency symbol as you want.

![Image of General Settings]

3. Added "Insufficient Balance Prompt" option.

Path: Addons → Billing Settings → General Settings

Instruction:

An insufficient balance prompt will be played when an insufficient extension is used to call out.
The custom prompt can be chosen if you have uploaded it to MyPBX "Custom Prompts" page.

**Path:** PBX → Audio Settings → Custom Prompts

4. Added "Extension Locked Prompt" option.

**Path:** Addons → Billing Settings → General Settings

**Instruction:**
An extension locked prompt will be played when a locked extension is used to call out.

The custom prompt can be chosen if you have uploaded it to MyPBX "Custom Prompts" page.

**Path:** PBX → Audio Settings → Custom Prompts
5. Added "Emergency Number" option.

**Path:** Addons → Billing Settings → Emergency Number

**Instruction:**
There is no charge for the emergency calls and the insufficient extensions can also make emergency calls.

**Path:** Addons → Billing Settings → General Settings

**Instruction:**
If set to Yes, you can call emergency number when you run out of credit. The emergency calls are free of charge.

6. Added "Scheduled Task" settings to lock or recharge extensions, or recover balance or charge in card for extensions periodically.

**Path:** Addons → Billing Settings → Scheduled Task
Instruction:
After setting the time condition, the system will lock or recharge extensions, or recover balance for the selected extensions periodically.

7. DISA and "Inbound-to-Outbound" features are available after enabling billing system.

Instruction:
DISA and "Inbound-to-Outbound" (set the inbound route destination to an outbound route) features were unavailable if billing system is enabled on MyPBX, but now they are supported. DISA and "Inbound-to-Outbound" calls are free of charge.

8. Added billing for mobility extension.
**Instruction:**

The mobility extension will be charged, and the bill is added to the corresponding extension.
Part 4: Hotel Addon

New Features

1. Added Hourly Room.
2. Added link of "Check In" and "Booking" in "Customers List".
3. Added "Comment" filed on "Customer" edit page.
4. Added MyPBX system time display on hotel web GUI.
5. Added the function that "Clean" status can be changed by double clicking the mouse.
6. Added the alert function on "Room List" page that the text of date will turn to red when the check out date comes.
7. Added group billing report.
8. Added "2 digits model" on Mini bar, which allows VAT to be set for each goods in Mini bar.

Optimization

1. A different type of room can be chosen when changing a room.
2. "Number" field and customer name are editable on Billing report.
3. Customers information can be downloaded and uploaded.
4. It is able to edit the information, including Check-in info, Mini Bar, Call info, Room info, Room Move info on "Room List" page.
5. Wakeup calls will also apply to the room which is not checked in.

Bug Fixes

1. Fixed the issue that the only left empty room cannot be checked in.
2. Fixed the issue a Certificate ID is needed when booking a room.

Instruction (New Features)

1. Added Hourly Room.
**Path:** Room Management → Add Model

**Instruction:**

Hourly room for hotel is supported.

2. Added link of "Check In" and "Booking" in "Customers List".

**Instruction:**

It is convenient for the administrator to do check-in and booking for the customers.
3. Added "Comment" filed on "Customer" edit page.

Instruction:
In this filed, enter the comment that the customer has left.

4. Added MyPBX system time display on hotel web GUI.

Instruction:
Once logging in the hotel web GUI, you will see a system time displayed obviously.
5. **Added** the function that "Clean" status can be changed by double clicking the mouse.

**Instruction:**
The clean status can be changed by simply double clicking the icon.

6. **Added** the alert function on "Room List" page that the text of date will turn to red when the check-out date comes.

**Instruction:**
7. Added group billing report.

Instruction:

After the customer checking out by group, there will be a billing report created. Check "By Group", all the group billing reports will be displayed.

8. Added "2 digits model" on Mini bar which will allow VAT to be set for each goods in Mini bar.

Instruction:

There will be more goods listed in the Mini bar by this model.

Instruction (Optimization)

1. A different type of room can be chosen when changing a room.

Instruction:

It is able to change a different type of room for customers. For example, room changed from Standard type to VIP type. As the room type changes, the bill charged will also change.
2. "Number" field and customer name are editable on Billing report.

Instruction:

![Billing report screenshot]

3. Customers information can be downloaded and uploaded.

Instruction:
4. It is able to edit the information, including Check-in info, Mini Bar, Call info, Room info, Room Move info on "Room List" page.

Instruction:

5. Wakeup calls will also apply to the room which is not checked in.

Instruction:

Some rooms in the hotel which are not checked in will have wakeup calls as well.
Part 5: MyPBX Client Addon

MyPBX Client Firmware Version: V1.0.0.7

New Features

1. Added Screen popup for call task when the time comes.
2. Contacts can be dragged by mouse to a group.
3. The dial pad will automatically adjust its position.
4. Added the function to integrate with outer CRM.

Bug Fixes

1. Fixed the issue that "Mobility extension" which is set on MyPBX will be changed while "Mobile" is changed on MyPBX Client profile.
2. Fixed the issue that the recording list cannot refresh automatically.
3. Fixed the issue that there is no caller name displayed if calling from MyPBX Client.
4. Fixed the issue that external numbers cannot be added in a conference.
5. Fixed the issue that the call log will be wrong if the external number dialed out has N-1 digits while the contact's number has N digits.
6. Fixed the issue that country code cannot be input manually on SMS GUI.

Instruction (New Features)

1. Added Screen popup for call task when the time comes.

Instruction:

When the time scheduled in call task has come, there will be a screen popup on the PC to remind MyPBX Client users.

2. Contacts can be dragged by mouse to a group.
**Instruction:**
Directly dragging the contacts to a group is possible.

3. The dial pad will automatically adjust its position.

**Instruction:**
If MyPBX Client window is placed on the left end of the desktop, the dial pad will be on the right of the MyPBX Client window.

If the window of MyPBX Client is placed on the right end of the desktop, the dial pad will adjust its position to left.
4. Added the function to integrate with outer CRM.

**Path:** Tools → Options → Calls → Integrate with outer CRM

**Instruction:**

If the option is checked, the CRM will automatically open if there is an incoming call to MyPBX Client users.
Release Notes for MyPBX U100&U200 15.19.0.X

MyPBX - Options

Calls

- Pop-up window when someone call in
  Dial Pattern

- Automatically answer dialing out
  Phone Type

- Integrate with outer CRM
  Command: http://110.23.3.89

The text "(callerid)" in the command will be replaced by the call in number when someone call in.

<The End>